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Introduction
This handbook is a collaborative effort on the part of Freedom of Information and Privacy Co-
ordinators from the Workers Compensation Board, Toronto Board of Education, Metropolitan
Toronto Police, Municipality of Metropolitan Toronto, Ministry of Community and Social
Services, and staff of Management Board Secretariat (MBS) and the Office of the Information and
Privacy Commissioner/Ontario (IPC).

The purpose of this handbook is to provide both provincial and municipal Freedom of Information
and Privacy Co-ordinators with an overview of why the Internet (Net) is an essential component of
any access and privacy program. The objectives of this handbook are:

• To present the range and capabilities of the Net in an access and privacy context;

• To provide a practical guide and examples of how to use the Net to provide better customer
service internally and externally;

• To increase the knowledge base and skill level of Co-ordinators in accessing information on the
Net that relates to their responsibilities under the Freedom of Information and Protection of
Privacy Act and the Municipal Freedom of Information and Protection of Privacy Act;

• To increase the awareness level of Co-ordinators about access and privacy issues related to the
Net.

The Net is a system of interconnected computer networks linked globally via the telephone system
or other telecommunications technologies. The use of the Net is quickly becoming an integral
feature of both the private and public sectors’ communications and information infrastructures. As
governments at all levels begin transferring their most used customer services and program
information to the Net, the ability to access this information becomes important in order to provide
the public with the most up-to date information possible.

The resources that Co-ordinators frequently use are information based and consequently excellent
candidates for placing on the Net. Both the IPC and MBS are transferring their program information
onto the Net. Accordingly, just as Co-ordinators must keep abreast of new IPC decisions, so must
they keep pace with the new technological advancements. This handbook will provide details on
how to prepare your business case if you do not have access to the Net.

The Net contains extensive information holdings including the most recent discussions and
publications about privacy issues, including biometrics, data sharing, encryption, privacy and
electronic records. These are all issues that will impact access and privacy programs. Access to the
Net provides Co-ordinators with the means of familiarizing themselves and their staff with these
issues and provides an excellent means of developing informed privacy and access policies.
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Benefits of Using the Net
Freedom of Information and Privacy Co-ordinators perform a wide range of tasks so that their
institutions can fulfill the statutory requirements of the Freedom of Information and Protection of
Privacy Act and the Municipal Freedom of Information and Protection of Privacy Act. These tasks
include:

• processing access requests and preparing appeal submissions;

•  responding to privacy complaints;

• compiling annual statistical reports for the Office of the Information and Privacy Commis-
sioner/Ontario for reporting purposes;

• providing access and privacy training;

• developing internal policies and providing in-house access and privacy advice.

Performing these tasks effectively requires Co-ordinators to conduct independent research and
exchange information and advice within government and with external groups including academ-
ics, other jurisdictions and the public. The Net is an excellent, cost efficient tool that is indispensable
for researching and communicating with others.

For example, in the past, the IPC issued its orders, investigation reports, and paper indices in paper
format. Yet, timely and efficient access to the orders and reports is often necessary in order to
respond to appeals and privacy investigations. In the past, such easy availability was not always
possible when the materials had to be purchased individually or ordered on a subscription basis, and
given the number of orders issued each year, this meant inefficient searching using paper indices.

Now orders are publicly available for the price of the on-line connection almost as soon as they are
issued and can be searched and downloaded from the Web. This cost is competitive with a
subscription to the paper version. In addition, the annotation of the Commissioner’s orders
prepared by MBS, a very important tool for Co-ordinators, will also be available on the Net.

For Co-ordinators, the Net provides another advantage, it allows them to become familiar with a
medium that is different from other media, a medium from which many access and privacy issues
will arise for their institutions in the near future.

The usefulness of the Net can be illustrated by the following sites:

• Information and Privacy Commissioner/Ontario: This site includes: IPC Practices, Perspectives
and policy papers as well as a subject index of the Commissioner’s decisions.
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These materials provide invaluable information on current access and privacy issues and
practical recommendations on ways an institution can avoid contravening privacy laws by
establishing good internal policies and practices. The subject index groups significant orders by
record type -- very useful in researching decisions.

• Corporate Freedom of Information and Privacy Office, Management Board Secretariat: The
site includes: the Acts and regulations, IPC decisions and privacy investigations, annotations of
decisions, the records listings of provincial ministries and agencies, a listing of all institutions
covered by either provincial or municipal Acts and the manual which advises Co-ordinators on
how to interpret the Acts. Any Coordinator processing requests or preparing appeal submis-
sions, training staff, looking for advice on a particular situation, wishing to contact another
Coordinator or trying to decide where to transfer a request will find this site very worthwhile.

• Web sites of Information and Privacy Commissioners across Canada and around the world, and
central agencies that administer access and privacy legislation in other jurisdictions.

• Government organizations or non-government organizations that are active in access and
privacy issues in Ontario, Canada and in other parts of the world, providing examples and
analysis of issues such as data warehousing.

• News groups with colleagues in similar organizations that implement access and privacy
legislation.

The last three kinds of sites are important to Co-ordinators interested in research and issue
awareness in order to provide policy and practical advice to their institutions in developing new
programs -- perhaps even Web sites. If, for example, a Coordinator is expected to provide policy
input on the access or privacy implications of proposed programs such as Alternative Service
Delivery, data matching, data warehousing or the use of biological identification, such sites will be
indispensable.
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Access and Privacy on the Net
The Net challenges us to think about access and privacy in a new way. Access to the World Wide
Web (Web) offers information at an unprecedented level. However, it can also threaten our privacy
as never before. It is critical that we be aware of these challenges so that we are in a better position
to maximize the benefits of the Net and minimize any loss of privacy.

Awareness is key. Co-ordinators should seek to make their organizations aware of the access and
privacy implications of using the Net and when considering placing information on the Web. Co-
ordinators should try to become involved in a project to utilize the Web at the early development
stage. The issues they could bring forward include the following:

Collection, Use, and Disclosure of Personal Information

• The collection, use, and disclosure of personal information, whether you are a user or a provider
of information, must take place within the framework of the Freedom of Information and
Protection of Privacy Act and the Municipal Freedom of Information and Protection of
Privacy Act.

• Consider the issue of disclosure of personal information. This issue may be particularly
important if you are considering posting public records which may contain personal informa-
tion (e.g., building permits). How could information be changed, combined, or matched?

• If you use or provide for transactions requiring personal information (e.g., online tax payments
or program registrations), is there adequate notice of collection and use, protection from
unauthorized access, and a provision for access to one’s own information?

• If you offer individuals online access to their own information, is there adequate protection
from unauthorized access, and manipulation and change?

Monitoring or Tracking of Use and Users

• Remember that monitoring or tracking of use and users can, does, and will happen.

• Monitoring or tracking may take place at many levels; by a provider of an institution’s use of
sites, by an institution of users of its site, and within an institution of its employees use of sites.

• Be aware of surreptitious collections of personal information. Cookies are a feature of Web
servers which allow for the collection and storage of information about your visit to a Web site
on your machine for future access by the server or other servers.
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• Online services can track and record activity. Such records of subscriber browsing patterns have
a commercial value to the service. They also may be embarrassing to users who have visited
controversial or provocative Web sites.

E-mail, Usergroups, Chat-lines

• No online activity or service can offer a guarantee of absolute privacy. There is no foolproof way
to authenticate the originator of a message or to be absolutely assured that an e-mail message was
not intercepted and changed.

• Remember that messages are available to a very broad audience. E-mail can be read, changed and
forwarded. E-mail is not a private communication.

• All communication on the Net is capable of being intercepted.

Policy Issues

• Does your institution have a policy on acceptable Net use, an online privacy policy, or an e-mail
policy?

• Do you have guidelines for users on protecting privacy on the Net?

• Does your Web site state clearly the institutional policy with respect to access and privacy? Does
your policy include notice that visitors’ addresses will be logged?

• Do you routinely ascertain the privacy policies of Web sites or service providers?

Security and Privacy

It is important to make a distinction between security and privacy; one does not equal the other.
Security deals essentially with confidentiality and preventing unauthorized access, while privacy
deals with a broader set of protections, starting with the appropriate collection of personal
information and extending to the proper use and disclosure of that information.

Security

• Personal information should be secure from inappropriate or unauthorized access.

• Firewalls should be used wherever possible to separate information placed on the Net from
information, particularly personal information, used for internal purposes.
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Glossary
The glossary of words or phrases provided below is not meant to be exhaustive or comprehensive,
but rather to serve to introduce some of the more popular words used in connection with the Net.

Bookmark

If you think of the Web as a book full of millions of pages, a bookmark on the Web acts much the
same way as it does in a real book -- it marks a site of interest for future reference.

Most Web browsers keep a history of the sites you have visited and have the ability to store a list of
addresses or URLs so you can retrieve them in the future. For example, with the Netscape Navigator
browser, stored items are called “Bookmarks.” Microsoft Internet Explorer’s equivalent is called
Favorites.

If you know a particular URL, you can type it in the location line and go to a file directly.
Alternatively, if you have bookmarked the URL, you can just go to Bookmarks, select it from your
list of bookmarks and then click to make the link to the desired Web page. Saving a list of URLs is
helpful because it is easy to get lost while surfing the Web, and bookmarks will help you find your
way back to Web sites you found interesting or useful. However, after a while you may find that you
have collected an enormous list of bookmarks. It is recommended that you purge your list
periodically and organize them, like sub-directories, under appropriate headings.

Browser

Browsers are programs or software that allow you to access the World Wide Web. They are the
information retrieval tools of the Web, as they allow you to view and interact with various kinds of
resources available on the Web.

The documents that browsers display are hypertext documents. This means that text can be linked
or referenced to other texts. Browsers let you use the links in a transparent way (i.e., select a link in
one document and then have the text from the referenced document presented to you on your
screen).
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Home Page

A home page is the first page or screen presented at a site on the World Wide Web. It acts like a table
of contents for the Web site, offering direct links to the different parts of the site. The usual address
for a Web site is the home page address, although you can enter the address (URL) of any page and
have that page sent to you.

HTML

This is an acronym for HyperText Markup Language. HTML is the computer language used to
create hypertext or linked documents. It creates the structure around the text, images, and other
parts of a Web page so that the file can be read by a browser.

HTTP

HTTP stands for HyperText Transfer Protocol and is the method by which hypertext files are
transferred across the Net. HTTP means that everyone using the Web to transfer hypertext files is
doing it the same way. HTTP is the standard and exclusive protocol of the Web. When the URL
begins with “http://”, the file will be displayed as hypertext with working links.

Internet (Net)

Generally called a “network of networks,” it is a loose confederation of networks around the world.
The networks that make up the Net are connected through several backbone networks. The Net
grew out of a U.S. Government project, and is specifically designed to have no central governing
authority or location.

Link

 This term generally refers to any highlighted words, phrases or graphics in a hypertext document
that allow you to “jump” to another section of the same document or to another document on the
World Wide Web. A browser usually displays a link in some distinguishing way, for example, in a
different colour, font or style.

When you place the cursor on a link, the URL of the linked page will appear at the bottom of your
screen. When you activate a link, usually by clicking on it with the mouse, the browser will initiate
the link. An example of a link on the IPC home page is “What’s New” which appears blue when you
first log on, and then changes to purple once you have used the link.
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Search Engines

These are the programs that allow you to search the Web (e.g., Alta Vista, Yahoo!, WebCrawler).
It is important to remember that not all search tools are organized in the same manner or have the
same indexing capacity. This means that you will get different results using different search engines.
Which one you use is often a matter of personal preference or familiarity.

Most search engines have icons for search options or tips on their home page. If you are not getting
the results you want from your searches, you may want to review these screens as the information
provided will help you focus or present your queries for better results with that particular search
engine.

URL

This is an acronym for Uniform Resource Locator. A URL is the address for a resource or site (usually
a directory or file) on the World Wide Web, and the convention that browsers use for locating files
and other remote services. URLs work something like telephone numbers, broadcast frequencies,
and call numbers of books in a library. It is a unique identifier for a site or file.

A URL includes a domain name (which is actually a unique Net server address) and a hierarchical
description of a file’s location on the server. For example, the URL of the IPC Web site is “http://
www.ipc.on.ca/”.

The first part of a URL, before the colon, tells you the type of resource or method of access at that
address. The part of the URL after the colon is typically the address of the computer where the data
or service is located. Additional parts may specify the names of files, the port to connect to, or the
text to search for in a database.

Here are a couple of other important things to remember about URLs:

• A URL has no spaces.

• A URL always uses forward slashes.

• Some URLs end with a single slash and leaving off this slash will sometimes produce an error.

• If you do not enter a URL exactly correctly, your browser will not be able to locate the site or
resource you want.
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Web Site

The Web site is a collection of network services, primarily HTML documents, usually called Web
pages, that are linked together and exist on the Web at a particular server. As an example, the IPC’s
Web site is located at http://www.ipc.on.ca/. All of the information contained on the different
screens are collectively considered to be the IPC’s Web site. Exploring a Web site usually begins with
the home page, which may lead you to more information about that site.

World Wide Web (Web)

The exact definition for the World Wide Web (popularly known as the Web or WWW) varies,
depending on whom you ask. In practice, the Web is a vast collection of interconnected documents,
spanning the world. Three common descriptions are:

1. A collection of resources (Gopher, FTP, HTTP, telnet, Usenet, WAIS and others) which can
be accessed via a Web browser.

2. A collection of hypertext files available on Web servers.

3. A set of specifications (protocols) that allows the transmission of Web pages over the Net.

You can think of the Web as a worldwide collection of text and multimedia files and other network
services interconnected via a system of hypertext documents. This non-linear, non-hierarchical
method of accessing information was a breakthrough in information sharing and quickly became the
major source of traffic on the Net. The World Wide Web Consortium (W3C) is the main standards
body for the Web.
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Tips on Using the Net

1. First Entering the ‘Net’

For those who have heard of the Net or the Web, but have not had the opportunity to use this
technology, the discussion below will try to provide some practical directions.

Freedom of Information and Privacy Co-ordinators are likely to find themselves in one of two
circumstances: 1) their organization has a connection to the Net, but this connection has yet not
been utilized by the Coordinator; or, 2) their organization has not yet been connected to the Net.

Starting in reverse order, when an organization seeks to ‘get connected’ to the Net, it will need to
consider the purchase of a modem, contracting with a service provider (Government of Ontario
organizations are connected through their own gateways), and obtaining a browser. If technical
expertise does not reside within the organization to install these components, outside consultants
should be considered.

If your organization is connected to the Net, two methods are likely: through a designated computer
terminal expressly set aside for Net use, or each individual terminal will have Interent access through
the organization’s internal network.

Though there may be some variation between organizations, a large number will utilize either
Netscape’s or Microsoft’s browser. We will explore Netscape since it is used in approximately 80%
of cases.

On Netscape, you will note a header with a coloured bar across the top and then four rows of boxes
and buttons, much like any windows application. The bar across the top of the screen contains the
Netscape logo and name, followed by the current Web site document name. The next row is the
menu bar containing: File, Edit, View, Go, Bookmarks, Options, Directory, Window, and Help.
Below are the toolbar buttons: Back, Forward, Home, Reload, Images, Open, Print, Find, Stop, and
Netscape. Next is the location text field which contains the URL of the site displayed on your screen.
Finally there are the directory buttons: What’s New, What’s Cool, Handbook , Net Search, Net
Directory, and Upgrades. You may not be able to use all of these buttons as some are not active.

This header appears on your screen, regardless of what site you are on, it is part of the Netscape
browser.
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2. ‘Surfing’ the Net

Once the browser header page is on screen, you have several options as to how to proceed.
Depending on which version of Netscape you have, you may have access to a number of pre-selected
bookmarks under various subject headings. You can view the bookmarks, and then click on the one
that interests you. The selected site will appear on your screen.

If you know the address or the URL of the site you want to visit, simply type that address into the
location text field (or the URL dialog box produced by the File/Open Location menu item) and press
return. The status bar at the bottom of the screen will indicate what is happening to the link (e.g.,
waiting for reply, loading, or done), and once the link has been made, the appropriate Web page will
appear on your screen.

If you want to find out what information is available on the Web on a certain topic, you should use
one of the Web search engines. Again, depending upon your version of Netscape, you may be able
to find some search engines already identified under your Bookmarks or under Directory/Net
Search. Alternatively, to get you started, the URLs of four search engines are:

• Open Text: http://www.opentext.com/

• Yahoo!: http://www.yahoo.com

• WebCrawler: http://webcrawler.com/

• AltaVista: http://www.altavista.digital.com/

Also, there are many sites that have compiled all the search engines and provide links. To identify
those sites, do a search on “search engines.” For easy reference, it is also recommended that you
bookmark the search engines you like so you can find them quickly.

3. Searching the Net

Each search engine is different, so it is recommended that you read the information provided on
their home pages, especially the Help sections, and then experiment. Generally you type in the word
or phrase you want to find and then press Enter and away you go. The search results will be displayed
on your screen once the search is completed. More sophisticated search engines operate with
Boolean logic capabilities that include the use of AND, OR and NOT. This is so that you may use
AND when you wish both words to be searched; or you can use OR when you wish either of two
or more words to be searched. Finally, you may include NOT when you want to exclude some word
or phrase from the search.
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If you are not familiar with searching, Yahoo! is a good place to start. AltaVista will generally provide
you with the largest number of search results from your query. Open Text is Canadian and often
finds more Canadian sites than do the American search engines.

The results of a search will appear on your screen, generally as a list of documents, files, or sites. The
list can be just a hypertext title or a more expansive description which includes a heading, the URL,
a brief description including size of document. In all cases the results will contain links to the
identified sites. Simply click on the highlighted words or phrase, a link to the selected site will be
made.

You will not be able to bookmark the results, but you can save the results by using the Save As option
under the File menu. It is suggested that you set up a separate subdirectory in your personal directory
for the files you download from the Web to make them easier to locate.

To limit the volume of results, be more specific, and read the information provided on the search
engine’s home page about searching. What you search on (e.g., a word or phrase) and how you
organize a query make a big difference in the results. Read the information provided by the search
engines.

If a desired link is not established, there may be a number of reasons why. Generally an error message
will appear to explain that something is wrong. Sometimes the Web is simply too busy; sometimes
there are technical problems; sometimes the site no longer exists; and sometimes there is no
information at the site at that moment so there is nothing to retrieve. You can try the Reload
function, or try making the link again, or try again another time. If a site is down, it may be down
for a few minutes or several days. Unfortunately, there is no way to tell.

4. Saving material from the Net

There are a couple of ways of saving information. You can simply add a bookmark so that the
information is easily and quickly accessible, without actually storing it on your computer.

If you want to save the entire page on your computer:

1. Click on the File menu

2. Select Save As

3. Indicate Drive and File Name

4. Press Okay
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There are a couple of points to understand when you are doing this. First, you should save into your
personal directory. You can select your directory under the “Save in” window that appears when
you select Save As. If you save an .htm file, you will need to “Open File” from the File menu in your
browser in order to read it.

The documents on the Web are in HTML. This means that they cannot be read, as is, by
WordPerfect. If you are only going to view the file through your Web browser, then it is okay to leave
it in HTML. However, if you want to be able to read and use the file in WordPerfect, you need to
convert it to a format WordPerfect can read.

When you open the Save As window, at the lower left corner, there is a “Save as type” heading. It
is here that you can change how you want to save the file. There are three choices: Source, Plain Text
and All Files. You can use any type but with Source and All Files, you will get all the source HTML
code and the text will be scrambled. By using Plain Text, the converted file will more closely resemble
a wordprocessing document.When you try to open a file in WordPerfect that you have saved from
the Web, a “Convert File Format” window will appear. Under the “Convert File Format From”
heading, you will note “IA5” in the window. Leave that as is and press okay. The file will
automatically be converted, although there still will be problems with the format. If you are having
a problem, try ASCII instead of IA5.

Also, to avoid unnecessary complications, when you save a file from the Web, you should not use
the following characters as part of a file name:

• slash (/)

• colon (:)

• number symbol (#).

If you want to copy and paste a Web page or just a portion of text from a page, you:

1. Highlight text using your mouse

2. Click on the Edit menu

3. Press Copy

4. Alt Tab to WordPerfect and select the file where you want to place the copied text

5. Press Paste button on Button bar

The selected content of the Web page is now in the wordprocessing document. Although there may
be a few format problems, you will be able to edit the copied information as you would any
wordprocessing document.
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5. Printing Material from the Net

You will see a Print button fourth from the right on the toolbar (the first set of buttons). When you
click on it, a print dialogue box (similar to the WordPerfect one you are used to) will appear. Make
your selections and press OK. The pages will be printed as you specified.

You can also choose the File/Print menu item. A print dialogue box lets you select printing options
and begin printing. There is also a Print Preview option in the File menu that you may select if you
want to see a screen display of the page to be printed.

6. Using E-Mail

If your organization is linked through a local area network, you are probably using e-mail to
communicate with your colleagues internally. You may also use the Net e-mail to communicate with
individuals across town, across the country, or across the world.

It should be remembered that e-mail not only is not private in terms of interception, but a message
is a government record, potentially accessible under the Freedom of Information and Protection
of Privacy Act.

Sensitive information, particularly personal information, should not be sent via e-mail. If it is to be
sent, the message should be encrypted.

Before you can send an e-mail from your Web browser, in essence, you need to identify yourself to
Netscape. To do this choose the Options/Mail and News Preferences/Identity menu item, then
complete the displayed form. Be aware that this now identifies you specifically on the Web and this
information will be captured by others.

To send e-mail you need to know the Net mail address of the destination. It is not recommended
that you use Netscape Mail under the Window menu item. Instead, choose the File/Mail Document
menu item. This produces the Send Mail/Post News dialog box. You may discover pages with a link
or button that also produce the Send Mail/Post News dialog box. Likewise, newsgroup pages with
a button for posting articles use this same facility. Once you are in the mail menu, a dialog box with
several text fields (e.g., From, Mail To, Post To, Subject, Attachment, etc.) will appear for you to
complete.

The Netscape Navigator Handbook contains a lot of specific information about how to send and
receive mail.
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Web Sites for Freedom of Information and
Protection of Privacy
From the perspective of the public who may wish to know more about the Acts as these are
implemented in a government organization, it should design its Web site to present information
about the Acts in a direct and easily accessible manner. Ideally, on the organization’s home page there
should be a hypertext link to further information about the Acts and whom to call within the
organization for more information or how to make a request for a record or personal information.
If this hypertext link cannot be on the home page, it should be found on a page that is logically or
functionally linked. For example, in many municipalities, the Clerk’s department is responsible for
administering the municipal Act, and a link from the Clerk’s web page to the Act’s should made.

It is important for the Coordinator, where possible, to participate in the development of their
organization’s Web site to enhance the visibility and accessibility of the Freedom of Information and
Privacy Office within the government organization, but more importantly, with the public.

The following are some suggestions to bring your office on-line. Starting with a simple entry on the
Web site home page to creating your own static or interactive Information and Privacy Home Page.

• Web Site Directory of Services

At the very least, for those Co-ordinators with offical Web sites, ensure that the Freedom of
Information and Privacy Office or program is listed on the home page (Main directory) with a direct
link to a screen which provides (i) a contact name and telephone/fax number of the FOI office within
your institution and; (ii) the offical mailing address for receipt of formal access requests.

• Freedom of Information and Privacy Office Home Page

Many provincial and municipal FOI offices have developed their own home pages. From the
organization’s main Web site, the user links directly to the FOI Office home page. Resources will
dictate the design and content of your home page and any connected screens.

• Directory of Records

Other types of information which an FOI office can make available from their Web site is the
organization’s Directory of Records or Routine Disclosure listing. If your Directory is in electronic
form, the document can be readily formatted into HTML which will enable the user to both view
and to download a copy of the Directory to his or her computer.
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• Access Request Application Forms

The access Request Application Form is another candidate for inclusion on an FOI Web site.
Building on the types of information available on an FOI home page, this technology enables us to
place the request form on our site in either HTML or PDF file. The form can be both viewed on-
line or downloaded to any personal computer for a user to complete. Accompanying instructions
would direct the user/requester to forward the request by regular mail, along with a five dollar
application fee to the appropriate FOI office for processing.

In addition to the IPC and Management Board Secretariat Web sites, you are encouraged to visit the
provincial and municipal Web sites to see the variety of ways in which FOI office programs can play
a part on the Net.

Listed below are some examples of Freedom of Information and Privacy sites:

Regional Municipality of Waterloo
Access to Information
http://www.oceta.on.ca/region.waterloo/gov/docs/govtaccess.html

Municipality of Metro Toronto
Corporate Access and Privacy Office
http://www.metrotor.on.ca/services/departments/corporate_access.html

Ministry of Health
Forms On-Line
http://www.gov.on.ca/health/index.html

The access and privacy Web page should include:

• A brief description of the Act.

• How one may request a record or personal information.

• Possibly a request form that can be copied (downloaded) off the Web site.

• Telephone, fax, or e-mail address of the Information and Privacy Coordinator, or some other
person responsible for administering the Act.
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Web Sites of Interest to Freedom of Information
and Privacy Co-ordinators

I. Ontario Government Organization

a) Management Board Secretariat (MBS) Corporate Freedom of Information and Privacy
Office

Ontario’s Freedom of Information and Protection of Privacy Act and the Municipal
Freedom of Information and Protection of Privacy Act (the Acts), are administered by
Management Board Secretariat’s Corporate Freedom of Information and Privacy Office.

The MBS Web site (http://www.gov.on.ca/MBS/english/fip/) is fully searchable elec-
tronically. It offers general information, what’s new and FAQ’s, as well as text of both
Acts and their Regulations, the Orders and Privacy Investigation Reports issued by the
Information and Privacy Commissioner, Annotations (summaries of orders and privacy
investigation reports), and the manual used by Freedom of Information Co-ordinators.

b) Office of the Information and Privacy Commissioner/Ontario

The Office of the Information and Privacy Commissioner/Ontario (IPC) is the independ-
ent tribunal that hears appeals and complaints and provides outreach on the Acts and
advice to government on its legislation and programs.

The IPC Web site (http://www.ipc.on.ca) lists the Orders by number, with hypertext
links to the full text. It contains IPC Practices, IPC Perspectives, and policy papers, as well
as a subject index of the Commission’s decisions. The IPC site also has links to many
other privacy and access sites. The site is also searchable.

c) Ontario Government

The Ontario Government Web site is located at http:www.gov.on.ca and provides an
entry to various Ontario government ministries and agencies. This site also has links to
the federal government FOI site, from which you can reach all provinces and territories.
The Ontario Government site also provides hypertext links to Ontario municipalities
with their own Web sites. A list of 72 cities and towns can be reached at: http://
www.gov.on.ca/ MBS/english/government/cities/index.html.
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II. Federal Government Organizations

a) The Privacy Commissioner of Canada’s site is at http://www.privcom.gc.ca/. It provides
information on the mandate and activities of the federal Privacy Commissioner. The site
contains publications, what’s new, other privacy protection sites in Canada, and other
sites of interest. You can link from here to Australia, Belgium, Germany, New Zealand,
the U.K., and Hong Kong.

b) The Office of the Information Commissioner of Canada may be found at http://
infoweb.magi.com/~accessca/ and provides a variety of resources ranging from speeches
and various reports to legislation.

c) Treasury Board’s site is at http://www.info.tbs-sct.gc.ca. Treasury Board is the federal
equivalent to Ontario’s Management Board Secretariat and is responsible for adminis-
tering the federal access and privacy legislation. A useful resource is the Manager’s
Deskbook, which contains information on access and privacy. It can be found at http:/
/www.info.tbs-sct.gc.ca/SIGS/html/TB_DESK/text/files/MD.e.html. Note, this address
is case sensitive; follow the upper and lower cases as written above.

d) The Government of Canada has an Net Guide which is both useful and fairly compre-
hensive. It is found at http://canada.gc.ca/programs/guide/main_e.html and explains
what should be put on a government Web site, gives a checklist, raises privacy and access
considerations, and warns about the accessibility of e-mail on the Net.

III.  Other Provincial Organizations

a) British Columbia’s Freedom of Information and Protection of Privacy Commission is
at http://www.oipcbc.org. The site has orders and other useful information about the
B.C. experience with information and privacy legislation. The orders are not searchable,
but listed from 1-190. You have to scan summaries of the orders to find one of interest,
but the full text is available.

b) Alberta’s Information and Privacy Commissioner lists all of its orders at http://
www.gov.ab.ca/foip/commissioners_orders/index.cfm. This site is searchable, and has
orders listed by year. The full text is available.

c) Other provincial sites can be found at the site of the Privacy Commissioner of Canada
at http://www.privcom.gc.ca/, as noted above.
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IV. Other Governments

a) The United States of America has an Office of Information and Privacy, Department of
Justice, at http://www.usdoj.gov/oip/oip.html. The Department of Justice publishes
information on U.S. privacy and access legislation on this site. It is a useful site with hot
links to the most useful resources, e.g. a comparison of the Privacy Act to the FOIA, a
guide to use of the Acts, and text of the Acts. However, it is not searchable.

b) Australia’s Privacy Commissioner has a Web site that links to its legislation, but there is
no search engine for the Act. The site is at http://www.hreoc.gov.au/hreoc/privacy/
privacy.htm.

c) New Zealand’s Privacy Commissioner has a Web site with features like “What’s New,”
links to other sites, including Canada, B.C., and Ontario, and the legislation (searchable
by section). It is located at http://www.knowledge-basket.co.nz/privacy/welcome.htm.

d) The U. K.’s Data Commissioner is at http://www.open.gov.uk/dpr/dprhome.htm.

V. Special Organizations

1. Privacy Oriented

a) Electronic Privacy Information Center (EPIC) has the latest news on privacy, links
to privacy resources and a search engine. Find it at http://www.epic.org.

b) Privacy Rights Clearinghouse helps consumers protect their privacy rights. The site,
http://www.privacyrights.org, has links to many privacy issues and resources.

c)  Appearing soon will be a new Web site that will provide comprehensive informa-
tion on all aspects of privacy, both in North America and around the world. It will
have extensive on-line resources available for anyone researching privacy issues,
covering both the private and public sectors. It will soon be found at: http://
www.PrivacyExchange.org.

d) Privacy Rights International is a watchdog on government and corporate surveil-
lance with members in 40 countries. It publishes a quarterly newsletter. The Web
site, http://www.privacy.org/pi, has Latest News, Issues, Resources, and Confer-
ences.

e) Electronic Frontier Canada is affiliated with the American Electronic Frontiers
Foundation which deals with a variety of Web related issues including privacy. The
address is http://insight.mcmaster.ca/org/efc/efc.html.
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f) Electronic Frontier Foundation is an American organization focusing on civil rights
issues on the Web, including privacy. The address is http://www.efc.org.

g) Net Privacy Coalition presents a mainly American focus on privacy and security on
the Net; http://www.privacy.org/ipc.

h) Privacy Forum is a moderated digest for discussion and analysis of issues related to
privacy in the information age. Readers can subscribe and receive messages and can
search the Privacy Forum archives. The address is http://www.vortex.com/
privacy.html.

i) The Computer Privacy Digest is a forum for discussion on the effect of technology
on privacy, and vice versa. Individuals can subscribe to it by sending a one-line e-
mail request to the moderator at comp-privacy-request@uwm.edu. Back issues of
the Digest can be found on the Web at http://www.uwm.edu/org/comp-privacy/.

j) Cu Digest is a weekly digest/newsletter/journal of debates, news, research and
discussion of legal, social and other issues relating to computer culture and can be
found at: http://www.soci.niu.edu/~cudigest.

2. FOI Oriented

a) The Freedom of Information Clearinghouse provides a guide and useful informa-
tion on U.S. federal FOI legislation. It can be found on Ralph Nader’s “Public
Citizen” site at http://www.citizen.org/public_citizen/litigation/foic/foic.html. You
may have to go to the Public Citizen site, then select the Litigation Group and from
there go to the FOI Guidebook.

b) The Society of Professional Journalists is found at http://www.spj.org/foia/index.htm.
This is a U.S. site that provides access to the latest developments at the federal level,
but also has links to state access laws and a guide on filing an FOI request. It has
a search engine.

VI. Journals

a) Management of Government Information (University of Saskatchewan) is an informa-
tive online journal that includes articles on freedom of information and privacy from a
Canadian perspective. See articles on government information on the Net, including
one writer’s experience using the Net: http://www.usask.ca/library/gic/.

b) The Journal of Information, Law and Technology is a useful journal for those
interested in European developments in the electronic information field. You can find
it at http://elj.warwick.ac.uk/jilt/default.htm.
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Conclusion
This guide is intended to assist Information and Privacy Co-ordinators to make use of the Internet
as a valuable tool to fulfill their responsibilities under the Acts. As information technologies become
less the exception in government organizations and more the routine way of doing business,
familiarity with these technologies, particularly the Internet, will assist Co-ordinators and provide
an opportunity to better serve the purposes of the Acts.



Information and Privacy Commissioner/Ontario
2 Bloor Street East, Suite 1400
Toronto, Ontario  M4W 1A8

416-326-3333
1-800-387-0073

Fax: 416-325-9195
TTY (Teletypewriter): 416-325-7539

Website: www.ipc.on.ca

Corporate Freedom of Information and  Privacy Office
7th Floor, Ferguson Block, 77 Wellesley Street West

Toronto, Ontario  M4W 1A8
416-327-2187

1-800-387-0073
Fax: 416-327-2190

E-mail: chauchar@epo.gov.on.ca
Website: www.gov.on.ca/MBS/english/lip/ginfo

Management Board
Secretariat
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